Панели инструментов Pattern Maker'a 

Включить/отключить панель инструментов можно, кликнув правкой кнопкой мыши в верхней части окна, где расположены панели. Тогда на экране появится контекстное меню, где галочками отмечены панели, находящиеся на экране в данный момент. Добавить панель - поставить соответствующую галочку. 

Панель "Main" (Главная)
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1 - создать новый файл схемы 

2 - импорт графического файла в новый файл схемы 

3 - открыть файл схемы 

4 - сохранить текущий файл 

5 - печать 

6 - вырезать выделенный фрагмент в буфер обмена 

7 - копировать выделенный фрагмент в буфер обмена 

8 - вставить фрагмент из буфера обмена на текущую схему 

9 - отменить действие 

10 - вставить схему из галереи 

11 - вызвать справку 

Панель "View" (Вид)
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1 - отобразить схему в виде крестиков 

2 - отобразить схему в виде символов 

3 - отобразить схему в виде цветных квадратов 

4 - показать информацию о схеме (символы, номера и названия цвета; количество ниток, необходимых для вышивки при заданной плотности канвы) 

5 - показать описание схемы (создать его, редактировать) 

6 - установить масштаб отображения схемы на экране 

7 - подогнать схему, чтобы умещалась на экране 

8 - вернуть предыдущий масштаб 

Панель "Commands" (Команды)
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1 - очистить текущую схему (убрать все стежки) 

2 - заменить цвет (подробнее см. в разделе Набор схемы) в выделенном фрагменте 

3 - заменить вид стежка (подробнее см. в разделе Набор схемы) в выделенном фрагменте 

4 - зеркально отобразить выделенный фрагмент по-горизонтали 

5 - зеркально отобразить выделенный фрагмент по-вертикали 

6 - повернуть выделенный фрагмент по часовой стрелке 

7 - повернуть выделенный фрагмент против часовой стрелки 

8 - закрасить пустые клетки выделенного фрагмента активным цветом (подробнее см. в разделе Набор схемы) 

9 - закрасить все клетки выделенного фрагмента активным цветом (подробнее см. в разделе Набор схемы) 

10 - в выделенном фрагменте провести контур активным цветом между стежками разных цветов 

11 - в выделенном фрагменте провести контур активным цветом между стежками и канвой 

12 - в выделенном фрагменте провести контур активным цветом по границе области выделения 

Панель "Palette" (Палитра)
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1 - вызвать палитру 

2 - отчет об использовании ниток 

3 - выделить активный цвет на схеме (при этом остальные цвета приглушаются - степень приглушения задается в меню Palette -> Highliting Options, в открывшемся окне бегунок внизу - чем правее, тем больше заглушены остальные цвета) 

Панель "View Options" (Настройка вида)
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1 - отобразить/убрать сетку 

2 - обвести стежки (видно при отображении схемы в виде стежков) - получается больше похоже на настоящую вышивку 

Панель "Drawing" (Рисование)
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1 - полный крест 

2 - "петит-пойнт" - полный крест на четверть клеточки 

3 - полукрест 

4 - полукрест на четверть клеточки 

5 - обратный стежок (бекститч, "вперед иголку") 

6 - прямой стежок 

7 - французский узелок 

8 - бисер (чтобы им рисовать нужно выбрать один из цветов, например, MillHill - производитель бисера) 

9 - специальный вид стежка 

10 - выделение прямоугольной области 

11 - выделение произвольной области 

12 - вставка текста на схему 

13 - заливка 

14 - пипетка 

15 - лупа (левой кнопкой мыши - увеличение, правой - уменьшение) 

Панель "Selected Stitch Types" (Выбранные типы стежков)
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1 - полный крест 

2 - "петит-пойнт" в левом верхем углу клеточки 

3 - "петит-пойнт" в левом нижнем углу клеточки 

4 - "петит-пойнт" в правом верхем углу клеточки 

5 - "петит-пойнт" в правом нижнем углу клеточки 

6 - полукрест слева направо 

7 - полукрест справа налево 

8 - полукрест на четверть клеточки в левом верхнем углу 

9 - полукрест на четверть клеточки в левом нижнем углу 

10 - полукрест на четверть клеточки в правом нижнем углу 

11 - полукрест на четверть клеточки в правом верхнем углу 

12 - обратный стежок 

13 - прямой стежок 

14 - французский узелок 

15 - бисер 

16 - специальный стежок 

Панель "Layout Font" (Шрифт описания)
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Кнопки на этой панели становятся доступными только при открытом описании схемы (кнопка 5 на панели "View") 

1 - название шрифта 

2 - размер шрифта 

3 - жирный 

4 - курсив 

5 - подчеркнутый 

Панель "Layout Tools" (Инструменты описания)
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Кнопки на этой панели становятся доступными только при открытом описании схемы (кнопка 5 на панели "View") 

1 - вставить/редактировать ключ (на экране появляется окно "Table Options", для выбора столбцов, которые будут включены в таблицу ключа, нужно нажать кнопку внизу "Choose/Edit Columns" и выбрать в списке слева нужные столбцы. Чтобы их добавить в таблицу, нажать кнопку "Use") 

2 - вставить картинку (схему или выделенный фрагмент (выделить фрагмент, выбрать в меню Edit -> Layout -> Mark Layout Region)) 

3 - вставить поле информации (название схемы, размер, ткань и др.) - заполняется в меню File -> Information 

Панель "Layout Paragraph" (Оформление абзаца описания)
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Кнопки на этой панели становятся доступными только при открытом описании схемы (кнопка 5 на панели "View") 

1 - абзац по левому краю листа 

2 - абзац по центру 

3 - абзац по правому краю 

4 - растянуть абзац по ширине листа 

5 - маркированный список 

6 - нумерованный список 

7 - увеличить отступ (при создании второго, третьего,.. уровня списка) 

8 - уменьшить отступ
Подготовка 

Выбор канвы 

Чтобы установить размер канвы, заходим в меню: Fabric -> Sizes. На экране появится окно "Fabric Properties" ("Свойства ткани"):
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Здесь устанавливается плотность переплетения (клеток на дюйм). Галочка справа "Square stitch" означает, что клеточки на канве будут квадратные. 

 Дальше нужно выбрать размер канвы: в дюймах или миллиметрах или же в клеточках (By specigying the size in stitches)

 ВНИМАНИЕ! Выбирайте размер канвы таким образом, чтобы линии сетки совпадали с линиями на исходной схеме. Так набирать намного проще. 

 Переходим на вторую вкладку окна "Fabric Properties" и выбираем цвет канвы (можно добавлять свои цвета и изменять уже имеющиеся). 

 Третья вкладка - здесь пишется тип канвы (по умолчанию - Aida). Эта информация будет на схеме при распечатке. 

 Четвертая вкладка - настройка сетки:
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Первая строка (Show major grid...) - через сколько клеток будут толстые линии (по умолчанию через 10 клеток). На некоторых (особенно маленьких) схемах бывает нужно показывать толстые линии через 5 клеток. 

Следующие две строки - настройки толщины и цвета тонких и толстых линий сетки для отображения на экране. 

Последние две строки - настройка линий сетки для печати и экспорта в графический файл. 

На каждой вкладке внизу есть галочка "Use for new patterns". Если ее поставить, то выбранные настройки канвы и сетки будут использоваться для новых схем (т.е. в следующий раз вам не придется делать все вышеперечисленное). 

Набор цветов в палитру 

 При создании новой схемы в палитре уже есть некоторый набор цветов. Но нам он не нужен - удалим все цвета. Для этого щелкаем правой кнопкой мыши на любом цвете в палитре и в появившемся меню выбираем "Delete All". Программа спросит, уверены ли мы? Отвечаем "Да". Теперь в палитре нет цветов. 

 Начинаем набирать нужные цвета. Чтобы вызвать палитру, нажимаем кнопку  в верхней части окна программы под меню. Если кнопки там нет, можно сделать двойной щелчок на пустой палитре или выбрать пункт меню Palette -> Colors. 

 В результате на экране появляется палитра (по умолчанию DMC(R)): 
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 Поводите мышкой по цветам - появляется подсказка с номером и названием цвета. 

 Чтобы добавить цвет в палитру, нужно сделать на нем двойной щелчок. При этом он должен появиться в палитре нашей схемы (внизу). 

 Чаще всего нужно набрать в палитру сразу много цветов. Сделать это проще так: ставим курсор в окошечко "Find" и набираем нужный номер цвета. При этом указатель цвета на палитре переходит на этот цвет. Теперь нажимаем "Enter" - цвет добавлен в палитру. 

 Обычно в схемах используются цвета DMC. Им в Pattern Maker соответствует стандартная палитра DMC (R). Там есть еще две палитры DMC - не знаю, что это за палитры. 

 Можете выбрать другую палитру в выпадающем списке "Type", например, Madeira или Anchor. 

Можно также делать смешанные цвета. Для этого нужно выбрать тип палитры "Blends". Нажать кнопку "New" и определить нужный цвет. Например, так: 
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Установка числа сложений нитей 

 Когда все цвета набраны (хотя это можно делать и после добавления каждого нового цвета - как хотите) нужно установить, во сколько сложений будем вышивать тем или иным цветом. Обычно эта информация дана в ключе к схеме. 

 Чтобы это сделать, переходим на вторую вкладку палитры: "Strands" 
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Full stitches - полный крест
Straight stitches - прямой стежок


Half stitches - полукрест
Back stitches - стежок "вперед иголку"


Quarter stitches - крест-четвертинка: 
Specialty stitches - специальный крест


Petite stitches - "петит-пойнт": 
French Knots - французский узелок


 Конечно, все это можно не задавать. Но тогда на просмотре результата в виде крестиков у вас получится меньше похоже на будущую вышивку. 

Подбор символов 

Для крестиков 

 Перебираем мы обычно неразборчивые символьные схемы. Поэтому, чтобы было удобнее, каждый цвет нужно обозначить максимально похожим на исходный символом. 

 Для выбора символов переходим на третью вкладку палитры: 
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 В списке "Font" выбираем шрифт. В Pattern Maker'e есть два шрифта специально для схем: CrossStitch3 и CrossStitch2 - они почти одинаковые. Если нужного символа в них не окажется, поищите его в обычных шрифтах (если это буква) или в Webdings, Wingdings (если это знак зодиака и т.п.). 

 Выбранные в данный момент символы выделены синим цветом. Чтобы назначить символ для цвета, нужно: 

1. Щелкнуть мышкой на нужный цвет в палитре нашей схемы. 

2. Сделать двойной щелчок левой кнопкой на нужном символе. 

 Что еще есть на этой вкладке? 

Кнопка "Make Default" - выбранный шрифт будет использоваться по умолчанию. 

Конопки "+" и "-" - сделать крупнее/мельче символы (на схеме это не отразится) - просто, чтобы было лучше видно. 

Кнопка "Auto Selection" - автоматический выбор символов. Не нажимайте!!! Иначе все подобранные символы заменятся другими. 

Кнопка "Use" - использовать этот символ для выбранного цвета (то же самое, что сделать двойной щелчок на символе) 

Кнопка "Unuse" - не использовать этот символ. 

Кнопка "Clear All" - убрать все назначенные символы (удобно, если надо все символы заново назначать). 

Галочка "Quick Entry" - как только вы выбираете символ для текущего цвета, указатель переходит на следующий цвет. 

Список "Show symbols for:" - очень интересно, только что для себя открыла эту возможность! Символы назначаются для типа крестика, выбранного здесь! (А я то раньше по два раза цвет в палитру вводила, чтобы для полного и половинного креста разные символы были). 

 Иногда на исходной схеме символы разного цвета (как у Dimensions). Тогда нужно наши символы раскрасить. 

 Переходим на четвертую вкладку палитры: 
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 Здесь можно выбрать цвет символа: "ForeGround". Если поставим галочку "Allow color behind symbols" ("Показывать символ на фоне цвета"), то можно еще выбрать цвет, на котором будет цветной символ: "Background". По умолчанию это текущий цвет из палитры ("Use actual floss color"), но можно выбрать другой ("Use alternative color"), нажав кнопку "Select". 

 Можно сделать символ жирным шрифтом и курсивом (галочки "Bold", "Italics"). 

 Проценты справа - размер символа для крестиков. 

 Нигде еще не видела, чтобы символ полукреста был не во всю клетку на схеме. Поэтому нам нужен символ полукреста во всю клетку схемы. Для этого заходим в меню: Palette - > Symbol Options и ставим там галочку "Use large half stitch symbols". 

Для прямых стежков 

 На многих схемах есть контуры - так называемый бэкститч. Чтобы задать обозначения для этого типа стежка, переходим на пятую вкладку палитры: 

[image: image18.png]Palette Options
Colos | Stends | Symbol | Symbol Fomat Bk St Symbcls | Sight . Sy | F ot

Cola:
Thickness:

Semple:

Use aermative color

05 ] poins

Select

Swe: |

PerSyle Dptons
™ Include stich endpaints





 Здесь выбираем цвет, которым будет обозначаться бэкститч на символьной схеме. Обычно это черный цвет. В списке "Color" выбираем "Use alternative color" и нажимаем кнопку "Select". Выбираем черный цвет. 

"Thickness" - толщина линии (для тонких линий ставьте 0,5 pt, для толстых - 1 pt). 

 "Style" - вид линии. 

 "Include stitch endpoints" - в help'e написано что разница такая: 
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Слева опция выключена, справа - включена.

Но я, если честно, на схеме так пробовла делать - разницы не видела. 

Для французских узелков 

 На некоторых вышивках нужны французские узелки. Символы для них назначаются на вкладке палитры "Fr. Knot Symbols": 

[image: image20.png]Palette Options
Cotas | Stands | Symbol | SymbolFomat| Back St Symbel | Saightst Smbos i Krot Sy

Colr:

e T -

Dismeter: [50_+] points

Semple: | o





 Опять же, лучше выбрать черный цвет (или какой у вас на схеме). "Diameter" - это, понятно, размер точки. 

 "Style" - выбираем, как будет обозначаться узелок: точкой или символом. Если вы не выбрали символ именно для узелка, то будет использован символ полного креста. 

Сохранение палитры 

Теперь лучше сохранить набранную палитру в отдельный файл - она потом еще пригодится. Для этого нужно выбрать в меню пункт Palette -> Save Palette as... В результате набранная палитра со всеми символьными обозначениями и т.п. будет сохранена в файле с расширением PAL.

Загрузка схемы 

В Pattern Maker'e есть очень удобная функция - можно сделать оригинальную схему "подложкой" и просто обводить ее. Пример: 
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Чтобы это сделать, нужно выполнить следующие шаги. 

1. Выбрать в меню File -> Import Image и дальше любой пункт: Import Into New Pattern - импортировать в новую схему Import Into Current Pattern - импортировать в текущую схему 

2. На экране слева появится Image Importing Wizard. На первом шаге выбирается файл с оригинальной схемой. В верхней строке нужно указать путь к этому файлу. Чтобы его найти, воспользуйтесь кнопкой Browse. Можно еще отсканировать картинку (тогда выберите опцию "Scan a photo" и нажмите кнопку "Scan") или использовать картинку из буфера обмена - третья опция. Нажимаем "Далее". 

3. На втором шаге указываем, как хотим импортировать картинку: "Convert the image into full cross stitches" - перевести в крестики, "Include image as underlay for tracing" - сделать подложкой. Нам нужна как раз вторая опция. Ставим там галочку, а с первой строки галочку убираем. Нажимаем "Далее". 

4. На третьем шаге можно отрегулировать яркость (Brightness), контраст (Contrast), насыщенность (Saturation) и оттенок (Hue). Чтобы сбросить настройки к первоначальному варианту (когда вы что-то поменяли, но не понравилось) - кнопка "Reset". Кроме этого на третьем шаге можно обрезать рисунок (например, если у схемы есть поля или ключ). Тогда выделяем область, которую нужно импортировать, и нажимаем "Crop". Отменить эту операцию - "Undo Cropping". Нажимаем "Далее". 

5. Самое интересное - наложение сетки. Увеличиваем схему, щелкая на ней левой кнопкой мыши (при этом должна быть вдавлена кнопка с лупой), чтобы отчетливо была видна сетка оригинальной схемы. Нажимаем кнопку с цифрами 1,2,3. Курсор превращается в крест с цифрой "1". Щелкаем на левый верхний угол квадрата из 10 клеточек оригинальной схемы. На схеме появляется крест, а курсор превращается в крест с цифрой "2". Щелкаем на правый верхний угол квадрата. Потом также на нижний правый угол. В результате получается так: 
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Больше никуда на схеме щелкать не надо. Иначе придется заново размечать сетку. 

Нажимаем "Align Grid". В результате на оригинальную схему накладывается виртуальная сетка. Она должна попадать на сетку оригинальной схемы как можно лучше. 

Если сетка наложилась не очень точно, нажимаем "Undo Alignment" и повторяем процедуру, пока не получится нормально. 

Не обязательно размечать квадрат из 10 клеток. Можно больше - но тогда в поле "Mark Spacing" проставляется нужное количество клеток. 

6. На следующем шаге ничего менять не нужно - размер канвы определен автоматически. Можно поменять плотность канвы - по умолчанию это Aida 14. 

7. Последний шаг - все готово к импорту схемы. Нажимаем кнопку "Import". 

8. Загружаем палитру (помните, мы ее сохраняли?). Для этого в меню выбираем Palette -> Open Palette. Выбираем нужный файл палитры. Это очень удобно, особенно если схема состоит из нескольких частей. Тогда не нужно для каждой части набирать палитру заново. 

Все. Можно приступать к набору схемы.

